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Présentation du cours

§ « Receiving – Inbound Processing » (Réception – Traitement des 
livraisons entrantes)

§ « Identify Queue Errors » (Identifier les erreurs de file d’attente)
§ « Internal Movements – Move goods to EWM » (Déplacements internes –

Déplacer les marchandises dans le module avancé de gestion d’entrepôt)
§ « Inventory Review – Display WHSE Stock » (Examen de l’inventaire –

Afficher le stock de l’entrepôt)
§ « Shipping – TU Outbound Wizard » (Expédition – Assistant sortant de 

l’unité de transport)
§ « Document Reprinting – Reprint Documents » (Réimpression de 

documents – Réimprimer des documents)

* Cette formation ne couvrira que le programme SAP Fiori®
Simple Logistics
SAP Fiori® est la marque de commerce ou la marque déposée de SAP SE ou de ses filiales en Allemagne et dans 
plusieurs autres pays.

Corcentric® est la marque de commerce ou la marque déposée de Corcentric, LLC ou de ses filiales aux États-Unis et 
dans plusieurs autres pays.

Les Outils Corcentric® et SAP 
Fiori® sont deux nouveaux outils.

L’Outil Corcentric® est utilisé pour 
signer les bons de commande, les 
documents de rapports de 
production, les notifications et la 
facturation d’expédition.

SAP Fiori® est utilisé pour recevoir 
des documents d’entrée, saisir des 
données de qualité et imprimer 
des étiquettes. 

Une fois ce cours terminé, vous serez en mesure 
d’effectuer des tâches suivantes :
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Aperçu du processus
3M
•Nous transmettons le bon de commande 

à notre sous-traitant

Outil de commerce électronique
• Envoyez un accusé de réception des bons 

de commande à 3M pour confirmer que 
vous pouvez respecter la quantité et la 
date de livraison

3M
Nous expédions n’importe quel avis sous la 
propriété de 3M à notre sous-traitant 

SAP Fiori® Simple Logistics
• Une fois que l’avis est reçu physiquement, 

effectuez la réception des marchandises

• Aide-mémoire : Diapositive 11 et suivantes

SAP Fiori® Simple Logistics
• Le déplacement interne a été créé pour 

déplacer les matériaux de l’entrepôt  à 
« stocker chez le vendeur » 
• Aide-mémoire : Diapositive 32 et suivantes

Outil de commerce électronique
• Le sous-traitant produit le rendement
• Le fournisseur met à jour les 

avis d’utilisation dans l’avis 
d’expédition préalable

SAP Fiori® Simple Logistics
• Les produits finis sont reçus au sein de 

l’emplacement d’entreposage du sous-
traitant en soumettant la réception des 
marchandises aux livraisons 
entrantes correspondantes
• Aide-mémoire : Diapositive 11 et suivantes

Site Web/appel
•Communiquez avec le contrôle de 

chargement pour organiser l’expédition 
(comme aujourd’hui)

SAP Fiori® Transportation Planning
• Le sous-traitant crée la commande de 

transport, assigne le transporteur et 
envoie les directives de chargement
• Aide-mémoire : Diapositive 42 

et suivantes

SAP Fiori® Simple Logistics
• Utilisez la vignette d’expédition pour 

sélectionner une unité de transport/la 
commande de transport pour activer et 
pour assigner les livraisons, ramasser, 
emballer et charger
• Aide-mémoire : Diapositive 42 et suivantes

SAP Fiori® Simple Logistics
• Une fois le matériel ramassé

physiquement, la vignette d’expédition est 
utilisée pour le produit d’émission de 
marchandises
• Aide-mémoire : Diapositive 65

Le site 3M ou le client de 3M reçoit 
le matériel 

Actions du sous-traitant
dans SAP Fiori® Simple Logistics ou dans 

SAP Fiori® Transportation Planning

Actions du sous-traitant
dans l’outil de commerce électronique

3M

Sous-traitant/contrôle 
de chargement

Qui fait quoi?

Les applications SAP Fiori® sont accessibles à partir d’un lien : Portail des partenaires
(https://partnerportal.3m.com/). 

https://partnerportal.3m.com/
https://partnerportal.3m.com/
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SAP Fiori® dispose d’un système de vignettes facile pour naviguer à travers les différentes applications et 
processus de l’outil.
§ Pour vous connecter à SAP Fiori®, accédez à l’URL https://partnerportal.3m.com/ et entrez votre NIP 

d’utilisateur et votre mot de passe, puis la page « Home » (page d’accueil) s’affichera.

Accéder à SAP Fiori®

Écran de connexion SAP Fiori®

https://partnerportal.3m.com/
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Page d’accueil de SAP Fiori®

§ La page d’accueil (« Home ») est le point d’entrée unique pour toutes les applications SAP Fiori®. Les 
applications sont organisées en groupes, qui contiennent des vignettes. 

§ Seuls les groupes nécessaires pour votre entreprise s’afficheront une fois que l’utilisateur a terminé la 
formation. L’utilisateur recevra une notification par courriel lui indiquant que son accès a été accordé.

§ Un utilisateur peut avoir accès à plusieurs applications sur la page d’accueil du portail des partenaires 
de SAP Fiori®.

§ Pour revenir à la page d’accueil à partir de n’importe quelle application, il y a une icône      d’accueil
sur laquelle vous pouvez cliquer.

Cliquez sur n’importe quelle 
vignette pour accéder à une 
application spécifique.
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Personnaliser SAP Fiori®

Pour personnaliser votre page d’accueil :

1. Cliquez sur « User Options » (Options de 
l’utilisateur)

2. Cliquez sur « Edit Home Page » (Modifier 
la page d’accueil)      pour passer en 
mode Modifier.

En mode Modifier, l’utilisateur peut :

• Glisser et déposer des vignettes.

• Ajouter des vignettes. 

• Masquer les vignettes inutilisées.

• Réinitialiser le groupe de vignettes.

• Organiser les vignettes en groupes.

1

2
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Personnaliser SAP Fiori® (suite)

Voici l’écran Modifier la page d’accueil :

Pour ajouter une 
vignette à votre 
page d’accueil, 
cliquez sur +.

Pour masquer une 
vignette sur votre 
page d’accueil, 
cliquez sur x.
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Portail des partenaires - Aperçu de SAP Fiori®

Pour un affichage optimal de l’écran, il est recommandé à l’utilisateur de changer 
le thème d’apparence dans les paramètres, en SAP® Belize ou SAP® Belize Deep 
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Terminologie de l’exécution de la logistique

Document qui utilise le module avancé de gestion d’entrepôt pour 
exécuter les déplacements de marchandises.

Warehouse Task
(WT) – [« Tâche d’entrepôt »]

Unité physique composée de matériaux d’emballage et des 
marchandises qu’il contient (carton, palette, caisse, etc.).

Handling Unit 
(HU) – [« Unité de manutention »])

L’emplacement physique d’un espace d’entreposage où les 
produits sont entreposés dans un entrepôt.

Storage Bin 
(« Bac d’entreposage »)

Fait référence à un envoi principal constitué d’une collecte de 
commandes/livraisons qui seront expédiées par camion, train, 
avion, etc.

Transportation Unit 
(TU) – [« Unité de transport »]

Matériaux qui seront reçus dans l’usine/l’entrepôt.
Inbound Delivery 

(IBD) – [« Livraison entrante »]

Matériaux qui seront expédiés de l’usine/l’entrepôt.
Outbound Delivery 

(OBD) – [« Livraison sortante »]

Départ physique des produits sur l’unité de transport 
(avis d’expédition). Déclenche la réduction du stock.

Goods Issue 
(GI) – [« Émission de marchandises »]
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« Receiving » (Réception)



© 2022, 3M. Tous droits réservés. 3M

SAP Fiori® Simple Logistics : « Receiving – Inbound Processing » 
(Réception – Traitement des livraisons entrantes)
Sur la page d’accueil, il y a une vignette « Receiving – Inbound Processing » 
(Réception – Traitement des livraisons entrantes)
Le nombre affiché sur la vignette est le nombre de livraisons entrantes

Dans ce module, l’utilisateur apprendra :
§ Comment cette vignette sera utilisée pour recevoir les 

livraisons entrantes 
§ Comment créer et rechercher des livraisons entrantes
§ Comment effectuer une réception de marchandises 

sur les livraisons entrantes

Cliquez sur « Receiving – Inbound Processing » 
(Réception – Traitement des livraisons entrantes)
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SAP Fiori® Simple Logistics : rechercher, sélectionner, créer
Dans SAP Fiori® Simple Logistics, l’utilisateur peut sélectionner une ou plusieurs livraisons entrantes.  
Effectuez une recherche par numéro de livraison entrante spécifique ou créez une nouvelle livraison entrante. 

Le processus de réception commence ici. Le matériel attribué à l’utilisateur sera une 
livraison entrante; l’utilisateur peut effectuer les opérations suivantes :

1. Sélectionnez plusieurs livraisons entrantes en cliquant sur le bouton de sélection 
multiple ou les livraisons entrantes disponibles seront répertoriées sur le côté 
gauche de l’écran.

2. Saisissez et recherchez une livraison entrante spécifique et appliquez des filtres si 
votre liste est trop longue – voyez comment faire cela sur la diapositive suivante.

3. Sélectionnez une livraison entrante dans la liste, utilisez la barre de défilement 
pour localiser la livraison entrante souhaitée et cliquez dessus ou les livraisons 
entrantes disponibles seront répertoriées sur le côté gauche.

4. Pour créer une nouvelle livraison entrante, cliquez sur le +.

3

2

4

1

* Remarque : Il est recommandé à l’utilisateur de ne pas créer de nouvelle livraison 
entrante, si possible. Le système ne permet pas aux données de circuler 
naturellement, ce qui pourrait entraîner des données manquantes ou d’autres erreurs.
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SAP Fiori® Simple Logistics : les filtres
Appliquez des filtres de recherche pour affiner la liste de livraisons entrantes à afficher :

Cliquez 
pour 
appliquer 
des filtres

Options 
de filtre

Cet exemple est filtré en sélectionnant « Open » 
(Ouverte) comme statut de la livraison entrante :

§ « Received, but Putaway not Completed » (Reçue, 
mais le rangement en stock n’est pas terminé)

§ « Partially Received, Putaway not completed » 
(Partiellement reçue, mais le rangement en stock 
n’est pas terminé)

§ « Partially Received and Putaway Completed » 
(Partiellement reçue et rangement en stock terminé)

§ « Partially Completed » (Partiellement terminée)
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SAP Fiori® Simple Logistics : créer une nouvelle 
livraison entrante
Il est possible de créer manuellement une livraison entrante, si celle-ci n’est pas dans Simple 
Logistics. L’utilisateur doit se trouver sur la page Détails de réception.
Pour créer une livraison entrante, l’utilisateur doit disposer d’un bon de commande SAP valide. 

1. Entrez tous les champs de l’en-tête de la livraison entrante* requis et cliquez sur            
2. Entrez la quantité à recevoir dans les articles de la livraison entrante, puis cliquez sur               

1
2

* Remarque : La création manuelle de la livraison 
entrante ne crée pas le numéro de lot, si nécessaire.
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SAP Fiori® Simple Logistics : traiter la livraison entrante/réception
Sélectionnez la livraison entrante à traiter pour passer à la page de « Receiving Details » (Détails de réception)

1. Lors de la création manuelle d’une nouvelle livraison entrante, la page de Détails de 
réception s’affichera.

• Le champ de la quantité reçue sera grisonné comme elle a été entrée précédemment.

2. Lors de la sélection d’une livraison entrante dans la liste disponible, la page de Détails de 
réception s’affichera.

• La quantité reçue sera par défaut la même que la quantité attendue, qui peut d’ailleurs 
être mise à jour.

2
1
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SAP Fiori® Simple Logistics : modifier la quantité reçue

Si l’utilisateur doit modifier la quantité reçue, entrer la bonne quantité et taper sur Entrée.

Suivez votre processus actuel pour apporter des modifications 
de quantité au reçu.
• L’utilisateur peut modifier la quantité reçue et taper 

sur Entrée
• Une fenêtre de confirmation s’affichera
• Si le changement est autorisé, la quantité sera mise à jour

* Remarque : Si l’utilisateur ne parvient pas à mettre à jour la 
quantité, un message s’affichera.
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SAP Fiori® Simple Logistics : le statut
Pour afficher le statut d’une livraison entrante et l’indicateur de maintien de 
l’assurance de la qualité.
§ Un cercle vert indique qu’aucune erreur n’existe.

§ Un cercle rouge indique que les erreurs existantes doivent être résolues (comme un lot manquant ou 
une date de péremption).  
• Cliquez sur le cercle rouge pour voir le message
• S’il s’agit d’un cercle rouge pour le maintien de l’assurance de la qualité, la ligne de commande est 

en attente pour une raison quelconque.

Dans cet exemple, une 
erreur existe.
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SAP Fiori® Simple Logistics : entrer les informations de 
lot manquantes

§ Lorsque le matériel est géré par lots, des informations sur le lot sont requises.   

§ Lorsque les données du lot ont été envoyées sur la livraison entrante, elles apparaissent dans le champ 
du lot.

§ Lorsque le matériel est géré par lot et que le champ est vide, l’utilisateur peut avoir besoin d’entrer le 
lot manuellement
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SAP Fiori® Simple Logistics : entrer les informations 
de lot (suite)
En cliquant sur le bouton + (ajouter), une fenêtre « Create Batch » (Créer un lot) s’affichera et les champs 
obligatoires sont les suivants :
« Product » (Produit), « Plant » (Usine), « Vendor Batch » (Lot du vendeur), « Batch » (Lot), « Manufacture Date » 
(Date de fabrication) et « Best Before Date » (Date de péremption).
Les champs Produit et Usine sont par défaut selon la livraison entrante.
Tapez le numéro de lot. 
« Man. Date » est la date de fabrication. Elle sera par défaut la date d’aujourd’hui. Ce champ peut être mis à jour, 
au besoin.
Une fois que vous avez entré les informations de lot requises, cliquez sur « Create » (Créer).
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SAP Fiori® Simple Logistics : entrer les informations 
de lot (suite)

Notez que le lot a été ajouté/mis à jour et que le statut est maintenant en vert.
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SAP Fiori® Simple Logistics : traiter la livraison entrante
Si les champs de statut et de maintien de l’assurance de la qualité» sont en verts, l’utilisateur peut 
traiter la livraison entrante.
Les options disponibles pour traiter la livraison entrante sont mises en évidence au bas de la page.  

Les sous-traitants sélectionnent seulement le bouton Créer pour terminer le processus de réception. Si l’utilisateur 
clique sur « Create + Confirm » (Créer + Confirmer) et qu’une confirmation n’est pas requise, le système affichera 
un message indiquant que les tâches d’entrepôt sont déjà confirmées. Cliquer sur « OK » pour continuer.

Toutes les options non valides seront grisonnées  
Voici les options possibles :
« Goods Receipt » (Réception des marchandises),
« Create » (Créer),
« Confirm » (Confirmer),
« Create + Confirm » (Créer + Confirmer) ou
« Reject » (Rejeter) : NE PAS UTILISER.  
Communiquer avec votre planificateur 3M

* Remarque : Il sera demandé à l’utilisateur si la quantité de réception doit être modifiée. Sélectionnez « Yes » (Oui) pour 
continuer. N’oubliez pas que si le changement de quantité n’est pas autorisé, le système affichera un message d’erreur 
indiquant la raison. Contactez votre personne-ressource de 3M si des modifications sont nécessaires et non autorisées.
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SAP Fiori® Simple Logistics : traiter la livraison entrante (suite)
Brèves descriptions pour le traitement d’une livraison entrante :

« Goods Receipt » 
(Réception des 
marchandises)

« Create » (Créer)

Effectue une réception de marchandises sur la livraison entrante.

Effectue une réception de marchandises et crée une tâche d’entrepôt de 
rangement en stock – cela sera utilisé par les sous-traitants.

Confirme les tâches d’entrepôt de rangement en stock (grisonnées - non 
utilisées par les sous-traitants).

Effectue une réception de marchandises et crée, puis confirme, les tâches 
d’entrepôt de rangement en stock. Pas utilisé.

« Reject » (Rejeter) Processus d’exception qui permet le rejet d’une livraison entrante. 
NE PAS UTILISER.

« Create + Confirm » 
(Créer + Confirmer)

« Confirm » 
(Confirmer)
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SAP Fiori® Simple Logistics : traiter la livraison (suite)

Une fois le processus de la livraison entrante terminé, un message de s’affichera; l’utilisateur doit cliquer 
sur  « OK » puis il sera redirigé vers la liste principale des livraisons entrantes.

* Remarque : L’état affiche « Completed » (Terminé) et le champ « WT » (Tâche d’entrepôt) est 
maintenant généré sur la page de Détails de réception. 

Un message s’affichera en cas d’erreur et indiquera comment résoudre le problème.
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« Identify Queue Errors » 
(Identifier les erreurs de file d’attente)
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SAP Fiori® Simple Logistics : identifier les erreurs de 
file d’attente
Sur la page d’accueil, il y a une vignette pour « Identify Queue Errors » (Identifier les erreurs de file 
d’attente). Le numéro affiché sur la vignette permet à l’utilisateur de savoir qu’il y a des erreurs de file 
d’attente actuelles enregistrées dans le système de votre entrepôt. Dans cet exemple, il y en a 16.

Remarque : Les erreurs de file d’attente empêchent les transactions subséquentes d’être traitées jusqu’à ce que 
l’erreur soit résolue.

Dans ce module, l’utilisateur apprendra :
§ Comment filtrer les rapports d’erreurs de 

file d’attente
§ Comment consulter/identifier les erreurs de 

file d’attente
§ Comment retraiter les erreurs de file d’attente

Cliquez sur « Identify Queue Errors » (Identifier les 
erreurs de file d’attente).
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« Queue Errors Report » (Rapport d’erreur de file d’attente) : 
les filtres

1. La page des rapports d’erreurs de file s’affiche

2. Entrez le numéro de livraison entrante ou de livraison sortante

3. Cliquez sur « Go » (Aller)

4. Les résultats seront affichés pour la livraison qui a été saisie

1

4

3
2
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Rapport d’erreur de file d’attente : les filtres (suite)

5. Entrez une date ou une plage de dates dans le champ « Created On » (Créé le) pour limiter le nombre 
d’erreurs affichées

6. Cliquez sur Aller

7. Les résultats seront affichés pour la date de création entrée

7

6
5
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Rapport d’erreur de file d’attente : onglets
Sous les champs de recherche « Delivery » (Livraison) et « Created On » (Créé le) se trouvent des onglets 
qui séparent les résultats en erreurs de file d’attente « Shipping » (Expédition), « Receiving » (Réception) et 
« Goods Movement » (Déplacement de marchandises).

Cliquez sur l’onglet « Receiving » (Réception) pour afficher les erreurs de file d’attente associées aux livraisons entrantes manquantes.

* Remarque : L’écran sera par défaut à « Shipping » (Expédition).
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SAP Fiori® Simple Logistics : identifier les erreurs de file 
d’attente (suite)
De nombreuses erreurs sont causées par 
des problèmes d’échance. Ces erreurs 
peuvent être résolues en :

1. Cliquant dans la case à côté de l’état 
et une coche apparaîtra

2. Cliquant sur « Reprocess » (Retraiter)

Un cercle noir dans l’état indique qu’il y a 
des erreurs dans le rapport. L’utilisateur 
peut cliquer sur « Reprocess » (Retraiter), 
ce qui efface généralement les erreurs.

1

2

* Remarque : Si l’état est noir ou vert, l’erreur de file d’attente peut avoir été récemment résolue par un 
retraitement manuel ou par une exécution de travail d’arrière-plan.
L’état de file d’attente « READY » (PRÊT) signifie que l’erreur a été résolue et que ces erreurs devraient 
disparaître la prochaine fois que le rapport est exécuté.
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SAP Fiori® Simple Logistics : identifier les erreurs de file 
d’attente (suite)

3. Lorsque le retraitement est réussi, ce message s’affiche

Lorsque le retraitement échoue, un message 
d’erreur s’affiche 

3
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« Internal Movements » 
(Déplacements internes)
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SAP Fiori® Simple Logistics : « Internal Movements – Move 
goods to EWM » (Déplacements internes – Déplacer les 
marchandises dans le module avancé de gestion d’entrepôt)
Sur la page d’accueil, il y a une vignette « Internal Movements – Move goods to EWM »
(Déplacements internes – Déplacer les marchandises dans le module avancé de gestion d’entrepôt).
Dans ce module, l’utilisateur apprendra :
§ Comment effectuer des déplacements internes 
§ À déplacer le produit vers « Stock at Vendor » (Stock chez le vendeur) permet à l’utilisateur d’utiliser le matériel 

entrant pour le processus de sous-traitance
§ À déplacer les matériaux d’un bac à l’autre

• Par unité de manutention (UM)
• Par Produit

§ À modifier le type de stock de produits
• Qualité
• Bloqué
• Disponible

Cliquez sur « Internal Movements – Move goods to EWM » (Déplacements internes – Déplacer les marchandises 
dans le module avancé de gestion d’entrepôt).
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SAP Fiori® Simple Logistics : « Internal Movements – Move 
goods to EWM » (Déplacements internes – Déplacer les 
marchandises dans le module avancé de gestion d’entrepôt)
Utilisez les Déplacement internes pour créer et confirmer une tâche d’entrepôt.  L’action la plus courante 
pour les sous-traitants consiste à déplacer le matériel vers « Stock at Vendor » (Stock chez le vendeur).

Les sous-traitants peuvent utiliser « Internal Movements » 
(Déplacements internes) et « Stock at Vendor » (Stock chez 
le vendeur).
§ C’est le déplacement du bac de réception du 
sous-traitant à « Stock at Vendor » (Stock chez le vendeur) 
le stock chez le vendeur est comme. Cette transaction doit 
avoir lieu, car l’inventaire doit être dans l’atelier « Stock at 
Vendor » (Stock chez le vendeur) pour être utilisé.

« Change Owner » (Changer de propriétaire)
§ Cette option est utilisée pour changer la propriété 

de l’inventaire de « Consigned » (Consigné) à 
« 3M Owned » (Propriété de 3M). Ceci est rarement 
utilisé, voire jamais.
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SAP Fiori® Simple Logistics : « Internal Movements – Move goods to 
EWM » (Déplacements internes – Déplacer les marchandises dans le 
module avancé de gestion d’entrepôt) (suite)
« From » (À partir de) est l’état actuel, où vous identifiez le 
matériau qui doit être déplacé ou changé.

Recherchez par « *Product » (*Produit) ou par « HU » 
(Unité de manunention). Cela remplit les données 
associées et élimine les problèmes liés aux informations 
manquantes nécessaires au système pour effectuer le 
déplacement.

* Le sous-traitant effectuera une recherche par produit  

Lorsque vous effectuez une recherche par produit, entrez le numéro d’identification du produit, puis cliquez sur 
l’icône de recherche. Le système affichera tout l’inventaire pour ce produit par unité de manutention.  Sélectionnez 
celui que vous souhaitez déplacer.

Lors de la recherche par unité de manutention, vous devez d’abord sélectionner l’icône de recherche, et cela fera 
apparaître une fenêtre contextuelle où vous entrerez dans l’unité de manutention. Après avoir tapé l’unité de 
manutention, cliquez sur l’icône de recherche pour trouver cette unité de manutention spécifique. Cliquez sur 
l’unité de manutention pour accéder aux données. 
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SAP Fiori® Simple Logistics – « Internal Movements – Move goods to 
EWM » (Déplacements internes – Déplacer les marchandises dans le 
module avancé de gestion d’entrepôt) : exemple
Voici un exemple de déplacement interne d’un bac.  Nous 
déplaçons 4 rouleaux du produit 7000000308 du bac 
« SHIP » (EXPÉDIER) au bac « GR-ZONE » (ZONE GR).

Remarque : Lors de l’exécution d’un deplacement de bac à bac avec 
une unité de manutention, la quantité de l’unité entière de manutention 
se déplace, quelle que soit la valeur entrée dans le champ « Qty » 
(Quantité) du côté « From ».

Remarque : Par défaut, le fournisseur utilise un numéro d’identification du 
fournisseur lorsque l’option « Stock at Vendor »  (Stocker chez le vendeur) est 
sélectionnée. Cliquez sur « Submit » (Soumettre) pour mettre à jour l’inventaire en 
« Stock at Vendor »  (Stocker chez le vendeur).

Voici un exemple de déplacement d’inventaire vers 
« Stock at Vendor » (Stocker chez le vendeur). C’est 
le plus courant pour les sous-traitants.
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« Inventory Review » 
(Examen de l’inventaire)
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SAP Fiori® Simple Logistics – « Inventory Review –
Display WHSE Stock » (Examen de l’inventaire – Afficher 
le stock de l’entrepôt)
Sur la page d’accueil se trouve la vignette « Inventory Review – Display WHSE Stock » (Examen de 
l’inventaire – Afficher le stock de l’entrepôt).
Dans ce module, l’utilisateur apprendra :
§ Le processus d’examen de l’inventaire pour tous les stocks du site

Cliquez sur « Inventory Review – Display WHSE Stock » (Examen de l’inventaire – Afficher le stock de l’entrepôt).
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Examen de l’inventaire – Afficher le stock de l’entrepôt (suite)

Pour afficher l’état de l’inventaire, la meilleure pratique consiste à filtrer par produit
spécifique. L’utilisateur peut afficher l’inventaire de tous les produits, en entrant un 
* dans le filtre du « Product » (Produit) et en appuyant sur la touche Entrée.

* Remarque : Pour affiner la recherche, l’utilisateur peut entrer des données dans chaque champ « Batch » 
(Lot), « Stock Type » (Type de stock), « Storage Bin » (Bac d’entreposage) et « HU » (Unité de manutention).
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Examen de l’inventaire – Afficher le stock de l’entrepôt (suite)

Les filtres de l’examen de l’inventaire comprennent :

Rechercher des produits dans un bac d’entreposage spécifique

Rechercher un produit spécifique ou tous les produits« Product » (Produit)

Rechercher des produits avec des numéros de lot spécifiques« Batch » (Lot)

Rechercher des produits avec un type de stock spécifique« Stock Type » 
(Type de stock)

« Storage Bin » 
(Bac d'entreposage)

Rechercher des produits dans une unité de manutention spécifique
« HU » 

(Unité de manutention)
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Examen de l’inventaire – Afficher le stock de l’entrepôt (suite)

Les options « Available » (Disponible) et « Physical » (Physique) offrent une vue détaillée. 
« Stock View » (Vue du stock) donne un aperçu de l’inventaire et « Stock at Vendor » (Stock chez le 
vendeur) affiche uniquement l’inventaire disponible dans « Stock at Vendor » (Stock chez le vendeur).

Lorsque les paramètres de l’utilisateur sont correctement configurés, le filtre Usine
se remplit. Remarque : Le filtre Usine s’affiche uniquement sous les onglets « Stock 
View » (Vue du stock) et « Stock at Vendor » (Stock chez le vendeur)

« Plant » (Usine)

Lorsque les paramètres de l’utilisateur sont correctement configurés, le filtre 
« Vendor » (Vendeur) se remplit. Remarque : Le filtre « Vendor » (Vendeur) 
s’affiche uniquement dans les onglets « Stock View » (Vue du stock) et « Stock at 
Vendor » (Stock chez le vendeur).

« Vendor » (Vendeur)

* Remarque : Si vous êtes sous-traitant, ces filtres sont configurés en fonction de l’emplacement de votre fournisseur
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« Shipping » (Expédition) 

REMARQUE : Cette section ne s’applique pas à la consommation à travers l’usine –
veuillez confirmer avec votre contact chez 3M
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Renseignements d’itinéraire

• Les sous-traitants continueront à 
utiliser https://trr.3m.com/trrweb/
afin de déterminer quel transporteur 
ils utiliseront pour leurs expéditions 

https://trr.3m.com/trrweb/


© 2022, 3M. Tous droits réservés. 3M© 2022, 3M. Tous droits réservés. 3M

Créer la commande de transport
Ouvrir « Freight Order Worklist » (Liste de travail de la commande de transport) sous « Transportation Planning » (Planification 
de transport)

Cliquez sur le bouton « Create FOR » (Créer la commande de transport) en bas de la page
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Remplissez les champs requis

Créer la commande de transport (suite)

Le type de document est ZF01

La ressource est DRY53

Ce champ se remplira automatiquement avec 
« DRY53 »

Le lieu de la source est le lieu de la source du 
sous-traitant

Déterminez la date de départ

Choisissez la destination

Déterminez la date d’arrivée

Quand tous les champs sont 
remplis, cliquez sur « Create » 
(Créer) pour compléter l’étape de 
création de commande de transport
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Enregistrez le numéro de la commande de transport créée
Celle-ci deviendra l’unité de transport planifiée qui sera activée à partir de la vignettre « Shipping » (Expédition) sous SAP Fiori® Simple Logistics
plus tard dans le processus et sera utilisé comme connaissement dans « Load Control » (Contrôle de chargement)

Créer la commande de transport (suite)
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Assigner le transporteur
1. Entrez l’information d’emplacement 

de votre source. Vous pouvez 
également ajouter le numéro de la 
commande de transport/du 
connaissement spécifique dans le 
champ « Document » (Document) 
ou faire une recherche pour la 
plage de dates à venir dans 
« Planned Load Date » (Date de 
chargement planifiée) pour affiner 
les résultats de recherche

2. Cliquez sur le bouton « Go » (Aller) 
3. Sélectionner l’entrée dans la case à 

cocher pour sélectionner le 
document à mettre à jour

4. Cliquez sur le bouton « Assign
Carrier » (Assigner un transporteur) 
pour associer le transporteur depuis 
« Load Control » (Contrôle de 
chargement)

5. Entrez le numéro du transporteur 
pour chercher pour celui-ci, puis 
cliquez sur les informations du 
transporteur pour le sélectionner

6. Cliquez sur le transporteur qui 
apparaît pour lui assigner la 
commande de transport
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• Sélectionner le ou les documents une fois le transporteur  assigné
• Cliquez sur le bouton « Load Instr » (Directives de chargement) pour envoyer les détails au module avancé de gestion d’entrepôt
• Cliquez sur « OK » sur la fenêtre contextuelle « Do you really want to send the loading or unloading instruction to the warehouse and save all 

changes in the freight order? » (Voulez-vous vraiment envoyer les directives de chargement ou de déchargement à l’entrepôt et enregistrer 
toutes les modifications dans la commande de transport?)

• Retournez à l’écran d’accueil 

Envoyer les instructions de chargement
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Pour ouvrir l’application d’expédition dans SAP Fiori® Simple Logistics, cliquez sur la vignette « Shipping » (Expédition) sur la page d’accueil.  

Assurez-vous que vous cliquez sur la vignette dans le groupe de vignettes spécifique à votre région. Actuellement, il y a deux groupes de vignettes :
§ SAP Fiori® Simple Logistics – C'est le groupe de vignettes mondial. Les utilisateurs doivent utiliser ce groupe de vignettes, à l’exception des 

utilisateurs dans la région Asie-Pacifique.
§ SAP Fiori® Simple Logistics (APAC) – Il s’agit du groupe de vignettes pour la région Asie-Pacifique. Si vous êtes dans un site de 

la région d’Asie-Pacifique, vous devrez utiliser ce groupe de vignettes puisque vous n’aurez pas d’accès ou de données dans le groupe de 
vignettes mondial.  

Cliquez sur un onglet du groupe de vignettes pour afficher votre groupe de vignettes en haut.  

Expédition
Ouvrir l’application « Shipping » (Expédition)
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Pour commencer, sélectionnez une unité de transport dans la « Master list » (Liste principale). La liste principale affiche par défaut uniquement les 
unités de transports de statut « Active » (Active). La toute nouvelle commande de transport créée sera l’unité de transport et sera au statut « Planned
» (Planifiée) jusqu’à ce que vous l’activiez. Si une unité de transport est au statut « Planned » (Planifiée) ou n’existe pas, vous pouvez changer une unité 
de transport au statut « Planned » (Planifiée) ou créer une nouvelle commande de transport pour pouvoir continuer avec l’émission des marchandises.  

Expédition : sélectionner une commande de 
transport/unité de transport
* Il est essentiel de se rappeler que la commande de transport que vous avez créée dans les étapes 
précédentes sera l’unité de transport avec laquelle vous travaillerez dans les étapes d’expédition suivantes *
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Expédition : trier et filtrer la recherche d’unités de transport

Vous pouvez également trier et filtrer les unités de transport. Triez ou filtrez par 
« Carrier » (Transporteur), « Status » (Statut) ou « Departure Date » (Date de départ).

1. Cette fonctionnalité n’est plus utilisée dans 
cette version de SAP Fiori® Simple Logistics

2. Cette fonctionnalité est utilisée pour 
changer l’ordre de tri des commandes de 
transport/unités de transport affichées

3. Cette fonctionnalité est utilisée pour filtrer 
la commande de transport/l’unité de 
transport par le transporteur « Carrier » 
(Transporteur), « Status » (Statut) ou 
« Departure Date » (Date de départ)
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Expédition : trier et filtrer la recherche d’unités de 
transport (suite)
Ce sont les fenêtres contextuelles qui s’affichent après que vous avez cliqué sur l’icône de filtre. Cet exemple 
montre les unités de transport filtrées par « Status » (Statut) puis « Planned » (Planifiée) :

Filtrer par « Planned » (Planifiée)Filtrer par « Status » (Statut)
Affichage des unités de 
transport « Planned » (Planifiée)

« Complete Status » (Statut complet) = L’unité de transport est une marchandise émise (expédition notifiée) et aucun 
changement ne peut être apporté.

« Invalidated Status » (Statut invalidé) = L’unité de transport a été annulée. Par conséquent, il est impossible de créer un 
envoi avec une unité de transport non valide.
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Expédition : sélectionner une unité de transport
Pour commencer, sélectionnez une unité de transport dans la liste des unités de transport principales :
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Expédition : sélectionner (suite)

Cet écran s’affiche après que vous avez sélectionné une unité de transport.

Les commandes de transport viendront 
de la vignette « Shipping » (Expédition) 
sous le statut « Planned » (Planifiée). 
Vous devrez cliquer sur « Activate » 
(Activer) pour les changer au statut 
« Active » (Active)
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Pour « Activate » (Activer)une unité de transport existante qui est de statut « Planned » (Planifiée) :
1. Cliquez sur l’icône de filtre        en bas de la liste principale.
2. Sélectionnez « Status » (Statut).  
3. Sélectionnez « Planned » (Planifiée). Cliquez sur OK.    
4. Maintenant, la liste principale affichera seulement les unités de transport au statut « Planned » (Planifiée). 

Expédition : activer une unité de transport
Activer une unité de transport
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Une fois que vous avez filtré et fait apparaîtreles unités de transport planifiées, vous pouvez continuer pour activer (« Activate ») 
une unité de transport :
1. Sélectionnez une unité de transport à partir de la liste principale.  
2. Cliquez sur « Activate » (Activer). Vous recevrez un message de réussite si 

l’activation a été réussie.  
3. Maintenant, l’unité de transport est sous le statut « Active » (Active).

Expédition : activer une unité de transport (suite)
Activer une unité de transport (suite)
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Expédition : sélectionner

Toutes les actions nécessaires pour effectuer l’émission de marchandises sont indiquées par le flux des 
processus. En fonction de la configuration de votre entrepôt, certaines étapes peuvent ne pas être 
nécessaires. Les tâches sont affichées ci-dessous.  

Aperçu de 
l’unité de 
transport

Attribuer la livraison

Ramasser Emballer

Examiner l’unité 
de transport, le 
chargement et 
l’émission des 
marchandises

* Remarque : Pour les sous-traitants, les tâches Ramasser et Emballer seront déjà effectuées pour le 
processus standard. 
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Expédition : attribuer les livraisons à l’unité de transport

Pour attribuer les livraisons :

1. Au besoin, utilisez les 
champs « Search » 
(Rechercher) pour 
rechercher et filtrer 
les livraisons. 

1. Sélectionnez 
« Delivery » (Livraison). 

2. Cliquez sur « Save » 
(Sauvegarder).

3. Le message de 
RÉUSSITE s’affiche.

* Remarque : Le statut en 
vert est le seul disponible 
pour l’expédition. Si le statut 
en rouge apparaît, les erreurs 
doivent être résolues avant 
que les marchandises soient 
disponibles pour l’expédition. 
Cliquez sur le cercle rouge 
pour afficher l’erreur.
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Expédition : voir les détails de la livraison
Consultez les détails de la livraison en cliquant sur l’icône de détails supplémentaires. L’état de la 
livraison et les détails l’article de la ligne sélectionnée sont affichés à l’extrême droite. 
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Expédition : ramasser et emballer
Pour les sous-traitants, les actions « Pick » (Ramasser) et « Pack » (Emballer) sont 
automatiquement marquées comme terminées       lorsque la livraison a été ajoutée. Vous 
pouvez maintenant passer à l’action « Review » (Passer en revue).

* Remarque : Une fois la livraison ajoutée, les actions « Pick » (Ramasser) et « Pack » (Emballer) sont 
marquées comme terminées. « Pick » (Ramasser) et « Pack » (Emballer) ne sont pas des actions 
obligatoires pour les sous-traitants, et ils peuvent maintenant passer à l’onglet « Review » (Passer en revue) 
où l’utilisateur peut charger et imprimer (« Load & Print ») le connaissement.
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Expédition : « Load & Print » (Charger et imprimer)
Notez que les actions « Pick » (Ramasser) et 
« Pack » (Emballer) sont affichées comme 
« Complétées » (Terminées).

Cliquer sur le bouton « Load & Print » (Charger 
et imprimer).

Le bouton « Load & Print » (Charger 
et imprimer)
- Exécute le chargement;
- Déclenche l’impression du connaissement et 
de tout autre document d’expédition configuré 
pour impression lors du chargement.

Un message « SUCCESS » (RÉUSSITE) 
s’affiche lorsque l’unité de transport est 
chargée avec succès.
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Expédition : « Unload TU » (Décharger une unité de transport)

Pour décharger une unité transport 
(« Unload TU ») :

1. Cliquez sur le bouton « Unload TU » 
(Décharger une unité de transport)

2. Un message « SUCCESS » (RÉUSSITE)
s’affiche lorsque l’unité de 
transport est déchargée.

3. Le statut « Load » (Charger) indique 
« Not Started » (Non commencé ») et 
le bouton « Load and Print » (Charger 
et imprimer) s’affiche maintenant.
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Expédition : supprimer la livraison de l’unité de transport

Si vous devez supprimer 
une livraison de l’unité de 
transport, cliquez sur 
l’icône de livraison et 
entrez votre livraison dans 
le champ de recherche

Décochez la livraison 
et cliquez sur 
« Save » (Sauvegarder).

Un message « SUCCESS » 
(RÉUSSITE) s’affiche 
lorsque l’unité de transport 
est supprimée.
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Expédition : supprimer la livraison de 
l’unité de transport (suite)

Quand la livraison a été supprimée : 

1. Les coches sont supprimées des 
sections  « Pick » (Ramasser) et 
« Pack » (Emballer) 

2. Dans l’onglet  « Review » (Passer en 
revue), les statuts indiquent « Not 
Started » (Non commencé) et les 
livraisons ne s’affichent plus sur 
l’unité de transport
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Expédition : émission de marchandises 
Lorsque vous êtes prêt à 
expédier, cliquez sur « Goods
Issue » (Émission de 
marchandises). Cela complète 
l’avis de livraison, libère 
l’inventaire et déclenche les 
états fincanciers.

* Remarque : Vous ne pouvez pas effectuer l’émission de marchandises 
(« Goods Issue ») à moins que les étapes Ramasser, « Pick » (Ramasser), « Pack » 
(Emballer) et « Load » (Charger) ne soient complétées. Si la transaction ne peut 
pas être complétée, une erreur s’affichera avec la résolution.
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Expédition : émission de marchandises (suite)

Lorsque l’émission des marchandises (« Goods Issue ») est terminée, 
tous les statuts s’afficheront comme « Completed » (Terminé). Le statut de l’unité de 

transport est complété sur la 
liste des unités de transport



© 3M, 2020. Tous droits réservés. Confidentiel à 3M.

s

« Document Reprinting » 
(Réimpression de documents

REMARQUE : Cette section ne s’applique pas à la consommation à travers l’usine –

veuillez confirmer avec votre contact chez 3M



© 2022, 3M. Tous droits réservés. 3M

« Document Reprinting » (Réimpression de documents) avec 
SAP Fiori® Simple Logistics

Sur la page d’accueil, il y a une vignette pour une « Document Reprinting – Reprint Documents » 
(Réimpression de documents – Réimprimer des documents).
Dans ce module, l’utilisateur apprendra :
§ La réimpression de documents pour tout type de documents 

Cliquez sur « Document Reprinting » (Réimpression de documents).
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Réimpression de documents (suite)

Pour réimprimer un document, choisissez une option dans la liste déroulante 
« I want to print » (Je veux imprimer). Entrez ensuite le numéro de document 
( « Doc Number ») requis et toute autre information demandée.
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Réimpression de documents (suite)
Ce tableau présente les options de la section « Document Reprint » (Réimpression de documents), 
le numéro de document (« Doc Number ») requis et d’autres informations demandées :

Option dans « Document 
Reprint » (Réimpression 
de documents) « Doc Number » (numéro de document, requis)

Autres renseignements 
demandés

Étiquette de l’unité 
de manutention

Numéro de l’unité de manutention (UM) • Imprimante
• Nombre de copies
• Format

Connaissement principal Numéro de l’unité de transport (UT)

Liste d’emballage Numéro du document PRE (livraison sortante)

Liste de ramassage Numéro du document PRE (livraison sortante)

Placard Numéro de l’unité de manutention • Imprimante
• Nombre de copies

* Remarque : Le connaissement principal, la liste 
d’emballage et la liste de sélection peuvent 
seulement être réimprimés. Les étiquettes et 
placards de l’unité de manutention peuvent être 
imprimés à tout moment, même si les 
documents ont déjà été imprimés une fois par 
l’entremise du processus d’expédition standard

Pour réimprimer une étiquette pour l’unité de manutention, vous devrez entrer le numéro de l’unité de manutention avec 
l’imprimante, le nombre de copies et entrer le format de l’étiquette (étiquette régulière, étiquette d’entretien ou étiquette A4). 

Pour réimprimer le connaissement principal, vous aurez besoin de l’unité de transport.
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Réimpression de documents (suite)

Une fois que vous avez entré les informations requises, l’application 
« Document Reprinting » (Réimpression de documents) valide la valeur entrée 
dans le champ « Doc Number » (Numéro de document). Si les entrées sont 
valides, vous verrez un ou plusieurs de ces boutons supplémentaires :

Imprimer

Afficher Effacer
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Réimpression de documents (suite)

Pour chaque réimpression d’un numéro valide de document, vous verrez l’un 
ou les deux boutons d’affichage et d’impression. Le bouton de suppression
s’affiche toujours.

Option de d’affichage et 
d’impression Affichage des boutons

Étiquette de l’unité
de manutention

Connaissement principal

Liste d’emballage

Liste de ramassage

Placard
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Réimpression de documents : exemple

Pour réimprimer une liste d’emballage :

1. Sous la liste déroulante « I want to print » (Je veux imprimer), sélectionnez « Packing List » 
(Liste d’emballage)

2. Entrez un numéro de document (« Doc Number ») et appuyez sur la touche Entrée.

3. Sélectionnez l’option d’affichage de l’impression.  

1

2

3
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Réimpression de documents : exemple (suite)

Le fichier PDF s’affiche. Enregistrez ou imprimez sur n’importe quelle imprimante. 

Enregistrez 
ou imprimez
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Conclusion

§ « Receiving – Inbound Processing » (Réception – Traitement des livraisons entrantes) 

§ « Identify Queue Errors » (Identifier les erreurs de file d’attente) 

§ « Internal Movements – Move goods to EWM » (Déplacements internes – Déplacer 
les marchandises dans le module avancé de gestion d’entrepôt)

§ « Inventory Review – Display WHSE Stock » (Examen de l’inventaire – Afficher le 
stock de l’entrepôt)

§ « Shipping – TU Outbound Wizard » (Expédition – Assistant sortant de l’unité 
de transport) 

§ « Document Reprinting – Reprint Documents » (Réimpression de documents –
Réimprimer des documents)

Les points clés abordés dans ce cours sont les suivants :
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Confirmation du cours 

Afin de compléter ce cours, vous devez compléter la confirmation d’apprentissage autonome.

Cliquez ici pour ouvrir la confirmation d’apprentissage autonome du cours 
sur le système PRE de l’Académie d’apprentissage pour fournisseurs 3M

Remarque : Si vous ne complétez pas la confirmation d’apprentissage 
autonome, vous ne recevrez pas de crédit pour le cours.


